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Notice

1.

10.

11.
12.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Notel) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.4.0-1 November 2017)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/0O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V. (Max.)
and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Vis (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK+ platform. It is
intended for users designing sample code on the RSK+ platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX72N microcontroller may be found in ‘RX72N Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK+ installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX72N Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK+ Renesas Starter Kit+ for R20UT4443EG
hardware. RX72N User’s Manual
Tutorial Manual Provides a guide to setting up RSK+ Renesas Starter Kit+ for R20UT4437EG
environment, running sample code and RX72N Tutorial Manual
debugging programs.
Quick Start Guide Provides simple instructions to setup the RSK+ | Renesas Starter Kit+ for R20UT4438EG
and run the first sample. RX72N Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Starter Kit+ for R20UT4439EG
Tutorial Manual importing into the CS+ IDE. RX72N Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK+. Renesas Starter Kit+ for R20UT4435EG
RX72N Schematics
Hardware Manual Provides technical details of the RX72N RX72N Group User’s RO1UHO0824EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ ngpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:

« Project Creation with CS+

« Code generation using the Smart Configurator.

o User circuitry such as switches, LEDs and a potentiometer

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT4439EG0100 Rev. 1.00 Page 8 of 67
Nov.29.19 RENESAS



Renesas Starter+ Kit for RX72N 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK+ platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the Smart Configurator for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
e ‘Debug’is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT4439EG0100 Rev. 1.00 NS Page 9 of 67
Nov.29.19 RENES




Renesas Starter Kit+ for RX72N

3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX72N

MCU, ready to generate peripheral driver code using Smart Configurator.

necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:

Windows™ 8.1: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

This project generation step is

e CS+ will show the Start Page. Use
the ‘GO’ button to Create a New
Project.

Create New Project
A new project can be crested.

A new project can also be created by reusing the file configuration registered to an existing project.

e In the ‘Create Project’ dialog, select

‘RX’ from the ‘Microcontroller’ pull-
down.
e In the ‘Using Microcontroller’ list

control, scroll down to ‘RX72N’ and
expand the tree control by clicking ‘+'.
Select ‘R5F572NNDxBD(224pin)’.

e Ensure that in the ‘Kind of project’ pull-
down, ‘Application(CC-RX)’ is selected.

e Choose an appropriate name and
location for the project, then click
‘Create’.

Note: this tutorial assumes the project
is named and located at the place
shown opposite.

e If the folder entered cannot be found a
‘Question’ dialog will be displayed;
click ’Yes’.

Microcontroller: RX
Using microcontroller:

B (Sea

nicrocontroller)

Update.

R5F572NDH:cLK[145pin) ~
RSF572NDH:LK_DUAL(145pin)
REF572NNDxBD_DUAL(224pin
R5F572NNDxBG (178pin)
REF572NNDxBG_DUAL(178pin

Product Name:R5F572NNDxBD
On-chip ROM size[KBytes]:4096
On-chip RAM size[Bytes]: 1048576

REF572NNDxF B(144pin) .

< >

Kind of project: Application(CC-RX)
Project name: SC_Tutorial
Place: Ciworkspace ~

Make the project folder

C:Workspace\SC_Tutorial'SC_Tutorial.mipj
[] Pass the file compasition of an existing project to the new project
Eroject to be passed:

Copy composition files in the diverted project folder to a new project folder.

Cancel

Additional Information:Package=PLBGO224GA-A

v

Browse

Browse.

Help

e CS+ will create the blank project with
the standard project tree. A ‘Smart
Configurator’ node may also be
shown, if previously enabled.

@ SC_Tutorial - CS+ for CC - [Property]

File Edit View Project Build Debug Tool Window Help

Bsat | JEHE@ X DEOC A B

SEEERE 0P3Q 3

" Solution List g

0 |

)

Project Tree 7 x Property

2 02@
-3 SC Tutorial (Project)*
E, R3F3T2NMD=BD (Microcontroller)
“[:Smart Configurator (Design Teol) |
-y, CC-RX (Build Tool)
-, R Simulator (Debug Tool)
r‘*) Program Analyzer (Analyze Tool)
E,’Tl File
& dbsct.c
‘d intprg.c
U resetprg.c
‘ﬂ shrk.c
& §C_Tutoriakc
‘j vecttbl.c
-] iodefine.h
A sbrich
U stacksct.h
u typedefine.h
h] vect.h

°:~I Smart Configurator Property
+  Product Information
Version

+ Smart configurator seffing

Smart Configurator for RX executable file path

R20UT4439EG0100 Rev. 1.00
Nov.29.19
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX72N has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX72N. When using Smart Configurator, it provides the user with a visual way of configuring the target
device, clocks, software components, hardware resources and interrupts for the project. Thereby bypassing
the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained in the RSK+ Web Installer
(https://www.renesas.com/rskrx72n/install/cs) and may be imported into CS+ by following the steps in the
Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these moddules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the
RSK+.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator.

R20UT4439EG0100 Rev. 1.00 RENESAS Page 11 of 67
Nov.29.19
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: CS+.

You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator (Design Tool)” in the project tree.
The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

Smart Configurator
File Window Help
=] =
{5} SC_Tutorialscfg 2 = 8 ||§ mMcu Package 2 = 8

CR=HIEE -] P B | L »

"

Overview information

This editor allows you to modify the settings stored in configuration file (.scfg)

Board

Allow board and device selection

Application under
Clocks development
Allow clock configuration

<-Companents

[ Middleware ] : i
Components Ml | B 90000008 POO00 6
driver ‘ RTOS ‘ ________________
Allow software component selection and configuration
S CStIr:ITIIl —~Pims

Pins
Allow general pin configuration and pin configuration for selected software compenent

Interrupt

Allow general interrupt configuration and interrupt configuration for selected software component

+ Current Configuration

Selected board/device: RSFST2NNDXED (ROM size: 4ME, RAM size: 1MB, Pin count: 224)

Selected components: v
Overview | Board | Clocks| Companents| Rins| Interrupts

&) Console 2 BEE| ™ & -~ [~ = 0O /[ configuration Problems 2 E
Smart Configurator Qutput

0 items
MB58BABA1: Pin K1 is assigned to CLKOUT25M A || Description
MB5e8eeRl: Pin J1 is assigned to EXTAL v

Ji

Type

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has

configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.

R20UT4439EG0100 Rev. 1.00 REN ESNS Page 12 of 67
Nov.29.19
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

i,?j,} SC_Tutorial.scfg &3

Device selection

Device selection

Board: | Custom User Board ~

Device: | R3F572MMND=ED

Over\.riew Clocks| Components | Pins | Interrupts

Figure 4-2 The ‘Board’ tabbed page

4.31 Board configuration

Make sure that ‘Custom User Board’ is selected for the ‘board:’.

8 5C_Tutorial.scfg E2

Device selection

Device selection

Board: ICustom User Board vI

Device: | RSF572ZMMNDxBD

Figure 4-3 Select board

R20UT4439EG0100 Rev. 1.00 RRENESAS
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

441 Clocks configuration

Figure 4-4 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-4.

ig¢ SC_Tutorial.scfg 232 = B8
Clocks configuration w &
vee |33 [\l
PLL circuit O,
- . SCKCR (FCLEE-01) FlashiF clock (FCLK)
Fraquency Division:
! x4 - 600 MHz)
y— - SCKCR (ICLK3:07)
o SCKCR (ICLKI3:00) System clock 0CL
¥ Main dock Fraguency Multiplication: 1 - —— o <§
Oscillsion sourcs:  Resonator = ¥ 00 LDE
x100 - p— .
o e SCKCR (PCLEAISD) Peripheral module clock (PCLKA)
Frequency: 24 (MHz) L $ -
R —® x1/2 1200 MHz)
Lscillanon wart time: .
SCKCR (PCLKBIZ0) Peripheral module dock (PCLKE)
9320 {us) actual valuz: 10000.000 us aa - 00 -
0 MHz)
SCKCR (PCLECISON Peripheral module dock (PCLKC)
x4 - 60.0 (MHz)
Sub-clock SCECR (PCLEDI3:01) Peripheral module dock (PCLKD)
x4 - 600 MHz)
Ll e SCECR (BCKI30] External bus clock (BCLK)
X3 - 500 MHz)
BCKCR (BCLKDIV)
— E—
/| SCKCR2 (UCKIZOD SDRAM clack (SDCLK)
PPLL circuit A5 -
HOCO clock Frequancy Divisian: USE clock [UCLK)/CACUCLE
PPLLCR3 (PPLCKIZ:0N) _ T
x5 - LLERS [PEL KL ) 480 MHz)
K R iz -
Frequency Multiplication:
X250 -
LOCO clock |
CLKOUTZ5M/CACCLEOUT25M
| xijg v ——— 250 MHz)
.
. CKOCR (CKODIV[2:0) CLKOUT pin
L= -
IWDT-dedicated dock |
CANMCLE/CACMCLE

24 (MHz)

Overview BoardlCIocksICDmponents Pins | Interrupts

Figure 4-4 The ‘Clocks’ tabbed page
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

4.5 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

{8t *5C Tutorialscfg 532

Software component configuration

Components = :%:D 52
%
type filter text
v [= Startup
v [= Generic
& rbsp

Overview | Board .ClockSICDmponentsl Pinsulnterrupts
Figure 4-5 Components page

451 Add a software component into the project

Smart Configurator supports four types of software components: Startup, Drivers, Middleware and Application.
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ & icon.

§8% *SC_Tutorial.scfg 53

Software component configuration

Components Jlebec =

type filter text

w [ Startup
~ [= Generic
& rbsp

Figure 4-6 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Mew Component

Software Component Selection |

Select component from those available in list

Type All ~

Function

Filter

uy

Figure 4-7 Add a Software component (2)
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

4.5.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-8 below then click ‘Next’.

MNew Component

Software Component Selection

Select component from those available in list

Type Drivers

Function |All ~
Filter |
s
Components Type Version 2
H# 8-Bit Timer Code Generator 1.7.0
H Buses Code Generator 180
# Clock Frequency Accuracy Me...  Code Generator 1.8.0
Iﬂ Comeare Match Timer Code Generator 2.00 |
$Comp|ementar}r PWM Mode Ti... Code Generator 180
## Continuous Scan Mode 512AD Code Generator 1.80
B CRC Caleulator Code Generator 1.80
B D/A Converter Code Generator 1.80
## Data Operation Circuit Code Generator 180 v
e - Pa— -~ . ann
< >
Show only latest version
Description
This software component provides configurations fer 16-bit/32-bit timer with
module CMT/CMTW and can generate interrupts at set intervals.
Download mere software components
Configure general settings...
® < Back Mext = I | | Cancel

Figure 4-8 Select Compare Match Timer
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+
In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO0’ as shown in Figure 4-9
below.

Mew Component

Add new config ion for sel d p
Compare Match Timer
Configuration name: |Config_CMTWO |
Resource: CMTWO ~
CMTWO
CMTW1
CMT1
CMT2
CMT3

Figure 4-9 Select Resource - CMT0

Ensure that the ‘Configuration name’ updates to ‘Config_CMTOQ’ as shown in Figure 4-10 below then click
‘Finish’.

New Component

Add new config ion for sel d P
Compare Match Timer
Configuration name: IConﬁg_CMTD I
Resource: CMTo v
@ | Conc

Figure 4-10 Ensure Configuration name - CMT0

In ‘Config_ CMTQ’, configure CMTO as shown in Figure 4-11. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Components L= - Configure
T Count clock setting
- ® PCLK/E OPCLK/32 OPCLK/128 O PCLK/512
type filter text
v (= Startup R Compare match setting
v [= Generic Interval value |1 I Ims VI (Actual value: 1)
-l Register value (CMCOR) (7499 |
w [= Drivers
v (&= Timers Compare match interrupt (CMIQ)
w Config CMTO Priority [ieveiio v
Figure 4-11 Config_CMTO setting
R20UT4439EG0100 Rev. 1.00 RENESAS
Nov.29.19
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-12 below.

New Component

Add new config ion for sel d

Compare Match Timer

Configuration name: | Config_CMTW0 |

Resource: CMT1 ~

CMTWO
CMTW1
CMTO

@ < Back Next > Cancel
Figure 4-12 Select Resource - CMT1

Ensure that the ‘Configuration name’ updates to ‘Config_ CMT1’ as shown in Figure 4-13 below then click
‘Finish’.

New Component

Add new configuration for selected component

Compare Match Timer

Configuration name: IConf\g,CMﬁ I

Resource: L£MT1 P

Figure 4-13 Ensure Configuration name — CMT1

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-14. This timer is configured to

generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components L= 2 Configure
+5 Count clock setting
P OpLs OPCLK/128 QPCLK/s12
¥
v G Startup = Compare match setting
w [= Generic Interval value IZO I Ims VI (Actual value: 20)
& rbsp .
e e Register value (CMCOR) [37490 |
w [= Timers Compare match interrupt (CMI1)
& Config_CMTO o g T
& Config CMT Priority |Level 10 : I
Figure 4-14 Config_CMT1 setting
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-15 below.

New Component

Add new config ion for sel d P
Compare Match Timer
Configuration name: | Config_CMTW0 |
Resource: CMTWO ~
CMTWO
CMTW1
CMTO

CMT3 '

@ < Back Next > Cancel
Figure 4-15 Select Resource — CMT2

Ensure that the ‘Configuration name’ updates to ‘Config CMT2’ as shown in Figure 4-16 below then click
‘Finish’.

New Component

Add new configuration for selected component

Compare Match Timer

Configuration name: IConf\g,CMTZ I

Resource: CMT2

Figure 4-16 Ensure Configuration name — CMT2

Navigate to the ‘Config_CMT2" and configure CMT2 as shown in Figure 4-17. This timer is configured to

generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components B - Configure
% = Count clock setting
- (O PCLK/E (O PCLK/32 OPCLK/128 (@ PCLK/512
type filter text
v (= Startup = Compare match setting
w [= Generic Interval value IZOD I Ims VI (Actual value: 200.004267)
odiens Register value (CMCOR) (23437 |
w = Drivers
v (= Timers Cornpare match interrupt (CMI2)
& Config_CMTO e g :
P fLevel 10 e
& Config_CMT1 oty L |
& Config_CMT2

Figure 4-17 Config_CMT2 setting
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

4.5.3 Interrupt Controller

Referring to the RSK+ schematic, SW1 is connected to IRQ13(P45) and SW2 is connected to IRQ12 (P44).
SW3 is connected to IRQ15(P07) and ADTRGOnN. This tutorial uses ADTRGOnN, which will be configured later

in §4.5.7.

Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Interrupt Controller’ as shown in Figure 4-18 then click ‘Next'.

Mew Component

Software Component Selection tlj-

Select component from those available in list

Type IDrivers VI
Function All v
Filter | |
Components Type Version @
8 Event Link Controller Code Generator 1.6.0
B General PWM Timer Code Generator 1.5.1
mGrnup Scan Mode 51240 Code Generator 180
8 12C Master Mode Code Generator 180
8 12C Slave Mode Code Generator 1.8.0
|Bi Interrupt Controller Code Generator 2.0.0 |
8 Low Power Consumption Code Generator 2.00
8 Normal Mode Timer Code Generator 1.8.0
E Phase Counting Mode Timer Code Generator 2.00 v
o cn oo P . ann
< >
Show only latest version
Description
Interrupt Controller configures the interrupt requests generated by [CU: Software
interrupt, NMI pin interrupt and IRQ External pin interrupts.

Download more software components

Configure general settings...

@ <gack | MNet> || Enish || Cancl

Figure 4-18 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ICU’ as shown in Figure 4-19

below then click ‘Finish’.

Mew Component

Add new config ion for sel d p tlj-

Interrupt Controller

Configuration name: | Config_ICU ‘

Resource: ICU ~

@ < Back Next > Cancel

Figure 4-19 Select resource — ICU
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-20

below.

Components =R

type filter text

v [ Startup
~ [= Generic
& rbsp
~ [z= Drivers
~ [= Interrupt
& Config_ICU
~ [= Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

2>

Configure

Software interrupt setting
[ software interrupt
[ Software interrupt 2

MNMI pin interrupt setting
CINMI pin interrupt
IRCYD setting

Oirao

IRQ1 setting
OIra1

IRQ2 setting
irRQ2

IRQ3 setting
1IR3

1RO setting
CJIRQ4

IRQS setting
C1IRQS

IRQ6 setting
Iras

IRQT setting
ity

IRQS setting
[]lek

IRQQ setting
[1IRQ9

IRQ10 setting
irato

IRQ1 setting
CJrRaM

IRQ12 setting
Elrarz

IRQY3 setting
Elrars

IRQ14 setting
C1IRQ14

IRQ15 setting
JrRQ1S

Level 15 (highest)

Falling edge

Low level

Level 15 (highest)

Low level

Level 15 (highest]

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest]

Low level

Level 15 (highest)

Low level

Level 15 (highest]

Low level

Level 15 (highest)

Detection type |Falling edge o

Priority |Level 13 (highest) w

Detection type i

Priority |Level 15 (highest) &

Low level

Level 15 (highest]

Low level

Level 15 (highest)

Dig

Dig

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Figure 4-20 Config_ICU setting
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

454 Ports

Referring to the RSK+ schematic, LEDO is connected to P71, LED1 is connected to PH6, LED2 is connected
to PL7 and LEDS is connected to PL6. PH3 is used as one of the LCD control lines, together with P02, PK7

and PLO.

Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Ports’ as shown in Figure 4-21 then click ‘Next'.

Mew Component

Software Component Selection

Select component from those available in list tlj
Type IDrivers VI
Function All v
Filter | |
Components Type Version @
8 12C Master Mode Code Generator 1.8.0

B 12C Slave Mode Code Generator 180

=] Interrupt Controller Code Generator 2.00

8 Low Power Consumption Code Generator 2.00

8 Normal Mode Timer Code Generator 1.8.0

E Phase Counting Mode Timer Code Generator 2.00

8 Port Output Enable Code Generator 1.8.0

i Ports Code Generator 2.0.0 |
B Programmable Pulse Generator ~ Code Generator 140 v
i imens P . ann

< >
Show only latest version
Description

This software component provides configurations for General Purpose Input/Qutput,
Commeon features such as reading, writing, and setting the direction of ports and

pins can be configured. Enabling features such as open-drain outputs and internal
pull-ups are also supported.

Download more software components

Configure general settings...

@ <gack | MNet> || Enish || Cancl

Figure 4-21 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-22

below then click ‘Finish’.

New Component

Add new configuration for selected component

Ports

Configuration name: | Config_PORT |

Resource: PORT ~

@ < Back Mext > Cancel

Figure 4-22 Select resource — PORT
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

Tick the tickboxes for ‘PORTQ’, ‘PORT7’, ‘PORTH’, ‘PORTK’ and ‘PORTL’ as shown in Figure 4-23 below.

Components = :%:D »  Configure
e m Port selection  PORTD PORT7 PORTH PORTK PORTL
type filter text
v B';:';UP _ ~ [ PORTO [C1roRT1
W ENEernc
oo _.r r_bsp [JroRT2 [poRT3
s FIvers
v E;-.I;il:egup: w [JPORT4 [poRTS
onfig_|
v E;-:rozort: - [JPORTS [ PORT?
onfig_|

W E& Tirners DPORTE- DPORTQ

& Config_CMTO
-r Config_CMT1 [1PORTA []PORTB

& Config_CMT2
[IPoRTC [IPoORTD
[JPORTE [CJPORTF
[JPORTG [~] PORTH
[ PORTK
[1PORTM
[1rorTQ

Figure 4-23 Select Port selection

Navigate through each of the ‘PORTX’ tabs, configuring these four 1/O lines and LCD control lines as shown in
Figure 4-24, Figure 4-25, Figure 4-26, Figure 4-27 and Figure 4-28 below. Tick the tickboxes for ‘Out’ and
tick ‘Output 1’ the tickboxes except for PLO under the ‘PORTL tab. Start with the 'PORTO' tab.

Components = 2 Configure
W Port selection | PORTO | PORT7 PORTH PORTK PORTL
type filter text
~ [ Startup - [l Applytoall
v& aneric Unused GPIO In Out Pull-up CMOS output Output 1
o rbsp
v [= Drivers POO
~ [= Interrupt
& Config_ICU @®Unused GPIO. OlIn - O0ut  [Pull-up  CMOS cutput Output 1 | Normal drive output
w [= I/0 Ports
& Config_PORT PO
v (= Timers ®Unused GPI0 Oin OCut OPull-up  [CMOS sutput Output 1 | Nermal drive output
& Config_CMTO
& Comtg.curs Fo
& Config |
CiUnused GPIO Oin Pull-up | CMOS output v Normal drive output ~
P03
® Unused GPIO OIn - (O 0ut I:‘Pu\l-up CMOS output Output 1
P03
@ Unused GPIO Clin (O 0wt [JPull-up CMO5 output Output 1
POT
@®Unused GPIO COlin O 0wt [JPull-up CMOS output Output 1
Figure 4-24 Select PORTO0 tab
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

Select ‘PORT7’ tab.

Components =] e Configure
% = Port selection  PORTO PORTH PORTK PORTL
type filter text
v (= Startup ~ [ apply to all
v & GS”EL" Unused GPIO In out Pull-up  |CMOS output Output 1
& rbsp
~ [= Drivers P70
w [= Interrupt
f Config_ICU @®Unused GPIO OIn O0ut  [JPull-up CMOS output Output 1 High-drive output
v [= /O Ports
& Config_PORT P71
v (= Timers OUnused GPI0 Oln Pull-up | CMOS output v| [EToutputT]
& Config_CMTO
& Config_CMT1 P72
& Config_CMT2
@UnusedGPI0 OIn Oout Pull-up | CMOS sutput Output 1 |Normal drive output
P73
@ Unused GPIO OIn O 0ut  [JPull-up CMOS output Output 1 High-drive output
P73
@Unused GPI0 OIn O out Pull-up | CMOS output Output 1 Normal drive output
P75
@ Unused GPIO OIn O 0ut  [JPull-up CMOS output Output 1 Normal drive cutput
P76
@ Unused GPIO OIn O 0wt [JPull-up CMOS output Output 1 Normal drive output
Pr7
@®Unused GPI0 OIn O 0ut  [JPull-up CMOS output Output 1 Normal drive output
Figure 4-25 Select PORT7 tab
Select ‘PORTH tab.
Components =] e Configure
% 5 Port selection  PORTO PORTT | PORTH |PORTK  PORTL
type filter text
v (= Startup ~ [ apply to all
v & GSI"IELI( Unused GPIO In Qut Pull-up CMOS output Output 1 MNormal drive cutput
& rbsp
~ [= Drivers PHO
w [= Interrupt
f Canfig_ICU @ Unused GPI0O Oln Couwt [ Pull-up CMOS output Output 1 Normal drive cutput
w [= /O Ports
& Config_PORT PH1
v = T.\_mer; @ Unused GPIO OIn O 0wt [JPull-up CMOS output Output 1 Normal drive output
& Config_CMTO
& Config_CMT1 PH2
& Config_CMT2
@UnusedGPI0 OIn Oout Pull-up | CMOS sutput Output 1 |Normal drive output
PH3
O Unused GPIO OIn Pull-up CMOS output ~ Normal drive cutput ~
PH4
@Unused GPI0 OIn O out Pull-up | CMOS output Output 1 Normal drive output
PH3
@ Unused GPIO OIn O 0ut  [JPull-up CMOS output Output 1 Normal drive cutput
PHE
OUnused GPIO D In Pull-up CMOS output e Normal drive cutput ~
PHT
@®Unused GPI0 OIn O 0ut  [JPull-up CMOS output Output 1 Normal drive output

Figure 4-26 Select PORTH tab
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

Select ‘PORTK’ tab.

Components az = :%> =

W

type filter text

v [= Startup A
v = Generic
& rbsp
v 2= Drivers
v [= Interrupt
& Config_ICU
v [= /O Ports
& Config_PORT
v = Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

Port selection

Configure

[ apply to all
Unused GPIO

PKO
(® Unused GPIO

PK1
(®) Unused GPIO

PK2
(@ Unused GPIO

PK3
(® Unused GPIO

PKA
(® Unused GPIO

PK3
(® Unused GPIO

PK&
(® Unused GPIO

PK7
() Unused GPIO

Oln

PORTO PORT7 PORTH | PORTK | PORTL

Out Pull-up CMOS output
O out |:|Pu||fup CMOS output
Oout  [JPull-up CMOS output
Oout  []Pull-up CMOS output
COout [JPull-up  CMOS output
Oout  JPull-up CMOS output
O out |:|Pu||fup CMOS output
Cout [JPull-up  CMOS output

Pull-up CMOS output

Output 1

Output 1

Output 1

Output 1

Output 1

Output 1

Output 1

Output 1

Normal drive cutput

Normal drive ocutput

MNormal drive cutput

Normal drive cutput

MNormal drive cutput

Normal drive cutput

Normal drive ocutput

MNormal drive cutput

Normal drive cutput

Select ‘PORTL’ tab.

Figure 4-27 Select PORTK tab

-
Components az = 2 -

W

type filter text

v [= Startup ~
w [ Generic
& rbsp
~ |22 Drivers
v [= Interrupt
& Config_ICU
v [= /O Ports
& Config_PORT
v (= Timers
& Config_CMTO
& Config_CMT1
& Config_CMT2

Configure

Port selection PORT0O PORT7 PORTH PGRTK

[JApply to all
Unused GPIO

PLO
() Unused GPIO

PL1
(®) Unused GPIO

PL2
(®) Unused GPIO

PL3
(®) Unused GPIO

PL4
(®) Unused GPIO

PL3
(®) Unused GPIO

PLE
(O) Unused GPIO

PLT
() Unused GPIO

Out Pull-up CMOS output
Pull-up CMOS output

O0out  [JPull-up CMOS output
Oout  [Pull-up CMOS output
Cout [OPull-up | CMOS output
) Out |:|Pu||fup CMOS output
O0out  [JPull-up CMOS output
Pull-up CMOS output
- Pull-up | CMOS output

Qutput 1

«| [JOutput1

Qutput 1

Qutput 1

Qutput 1

OQutput 1

Qutput 1

MNormal drive output

Nermal drive output

Nermal drive output

Normal drive output

MNormal drive output

Nermal drive output

Nermal drive output

Normal drive output

Mormal drive output

Figure 4-28 Select PORTL tab
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Renesas Starter Kit+ for RX72N

4. Smart Configurator Using the CS+

4.5.5

SCI/SCIF Asynchronous Mode

In the RSK+RX72N, SCI9 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as

shown in the schematic.

Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SCI/SCIF Asynchronous Mode’ as
shown in Figure 4-29 then click ‘Next’.

MNew Component

Software Component Selection
Select component from those available in list .dj‘
Type IDrwers VI
Function | All v
Filter | |
Components Type Version @
H# Real Time Clock Code Generator 1.5.0
H SCI/SCIF Asynchronous Made Code Generator 1.8.0 |
B8 SCI/SCIF Clock Synchronous M... Code Generator 1.80
8 Single Scan Mode 5124D Code Generator 2.00
B Smart Card Interface Mode Code Generator 180
B SPI Clock Synchronous Mode Code Generator 180
8 5Pl Operation Mode Code Generator 1.70
F# Voltage Detection Circuit Code Generator 180
BWatchdUg Timer Code Generator 180 v
< >
Show only latest version
Description
This software component provides configurations for SCI{SCIF) single(multi-
processor) asynchrenocus mode,
Download more software components
Configure general settings...
@ < Back I Next > I I Einish I Cancel

Figure 4-29 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as

shown in Figure 4-30 below.

New Component

Add new configuration for selected component

SCI/SCIF Asynchronous Mode

Reception

Transmission/Reception

Multi-processor Transmission
Multi-processor Reception
Multi-processor Transmission/Reception

Configuration name: Config_SCID

Work mode: Transmission ~
Transmission

Resource:

@ < Back Mext >

Cancel

Figure 4-30 Select Work mode — Transmission/Reception
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Renesas Starter Kit+ for RX72N 4. Smart Configurator Using the CS+

In ‘Resource’, select ‘SCI9” as shown in Figure 4-31 below.

MNew Component

Add new configuration for selected component -E-

SCI/SCIF Asynchronous Mode

Configuration name: Config_SCI0 |

Work mode: Transmission/Reception ~

Resource: SClo ~

SCI0
s5CH
SCI12
sCI3
SCI4
SCI5
s5Cle
SCI7
S5CI8
SCHO
SCI
SC12

® < Back Mext > Cancel
Figure 4-31 Select Resource — SCI9

Ensure that the ‘Configuration name’ is set to ‘Config_SCI9’ as shown in Figure 4-32 below then click ‘Finish’.

Mew Component

Add new configuration for selected component -E-

SCI/SCIF Asynchronous Mode

Configuration name: IConfig_SCI‘} I
Work mode: Transmission/Reception ~
Resource: 5CI9 %

® < Back MNext = Cancel

Figure 4-32 Ensure Configuration name - Config_SCI9
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Configure SCI9 as shown in Figure 4-33. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD9 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components =] ::: ~  Configure
% FIFO mode setting
- @ Nen-FIFQ mode
type filter text
© & Startup " Start bit edge detection setting
v = Generic (O Low level on RXDS pin
. & rhsp Data length setting
w [= Drivers 9 bits
v [= Interrupt
& Config ICU Parity setting
~ [= I/0 Ports (® None
& Config PORT )
v (= Communications Step bit length setting
& Config 5CI9 ® 1 bit
Ve Tl_m;rs fig CMTO Transfer direction setting
& Config_ .
& Config_CMT1 ® Ls-first
@ Config CMT2 Transfer rate setting
Transfer clock
Bit rate
[JEnable medulation duty correction
SCKS pin function
Moise filter setting
] Enable noise filter
Hardware flow control setting
(® None
FIFO data setting
v Data match detection setting

[[Enable data match detection

Data handling setting

Transmit data handling

Receive data handling

Interrupt setting

THIS priority

RXI9 priority

Enable reception error interrupt (ERIZ)
TEI9, ERIY priority (Group ALD)

Receive data ready interrupt

Callback function setting
[ Transmission end

(O FIFO mode
®) 8 bits
() Even
O 2 bits

() MSB-first

Internal clock

16 cycles for 1-bit period

O7 bits

Oodd

[ 13200

~|

(bps) (Actual value: 19230.769, Error: 0.16%)

SCKS is not used

Clock signal divided by 1

O CTses
15

)

Data handled in interrupt service routine

Data handled in interrupt service routine

Level 15 (highest)

Level 15 (highest)

Level 15 (highest)

Receive data full interrupt (RXI)

Reception end

(O RTsgz

Reception eror

Figure 4-33

Config_SCI9 setting
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4.5.6 SPI Clock Synchronous Mode

In the RSK+RX72N, SCI7 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as
shown in Figure 4-34 then click ‘Next'.

Software Component Selection

Mew Component

Select component from those available in list

Type I Drivers VI
Function | All ~
Fitter | |

Components Type Version =

8 Real Time Clock Code Generator 150

8 5CI/SCIF Asynchronous Mode Code Generator 1.8.0

8 SCI/SCIF Clock Synchronous M. Code Generator 180

ESmgIe Scan Mode 5124D Code Generator 200

8 Smart Card Interface Mode Code Generator 1.8.0

H SPI Clock Synchronous Mode Code Generator 1.8.0 I

8 5Pl Operation Mode Code Generator 170

E\u‘oltage Detection Circuit Code Generator 1.8.0

## Watchdog Timer Code Generator 180 v

< >
Show only latest version
Description

This component provides clock synchronous operation of RSPI or SCI (Simple 5P

bus). It includes 4 transfer modes: Slave transmit/receive, Slave transmit, Master

transmit/receive and Master transmit.

Download more software components

Configure general settings...

@ < Back I Mext = I | Einish | Cancel

Figure 4-34 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown

in Figure 4-35 below.

Add new config ion for p

New Component

SPI Cleck Synchrenous Mode

Configuration name: | Config_RSPID |

Operation: Slave transmit/receive ~

Slave transmit/receive
Resource:

Slave transmit only

Master transmit/receive

® w1t Conce

Figure 4-35 Select Operation — Master Transmit
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In ‘Resource’, select ‘SCI7’ as shown in Figure 4-36 below.

MNew Component

Add new configuration for selected component

5PI Clock Synchronous Mode

Configuration name: Config_RSPID

Operation: Master transmit only

Resource: RSPID

R5PID
R5PIT
R5PI2
SClo
sCn
SCi2
SCI3
SCl4
SCl5
SCI6

SCIg
sCl9
scio
sCm
sCn2

® T

Cancel

Figure 4-36 Select Resource — SCI7

Ensure that the ‘Configuration name’ is set to ‘Config_SCI7’ as shown in Figure 4-37 below then click ‘Finish’

MNew Component

Add new configuration for selected component

5PI Clock Synchronous Mode

Configuration name: IConfig_SCI?

Operation: Master transmit only

Resource: 5CI7

® TER

Cancel

Figure 4-37 Ensure Configuration name - Config_SCI7
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Configure SCI7 as shown in Figure 4-38. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 15000 kbps. All other settings remain at their defaults.

Components = v Configure
%= Transfer direction setting
type filter text () LSB-first (®) MSB-first
w [= Startup ~ Data inversion setting
Generi
= _enerlc ® Normal ) Inverted
W rbsp
v (& Drivers Transfer speed setting
v [= Interrupt
& Config_ICU Transfer clock Internal cleck (SCKT pin functions as clock output pin) ~
~ [= /O Ports X B . -
& Config_PORT Bit rate 15000 (kbps)  (Actual value: 15000, Error: 0%)
v [= Communications []Enable modulation duty correction
& Config_5CI7
& Config_5CI9 Clock setting
A E&Ti_mers [[JEnable clock delay [[JEnable clock polarity inversion
& Config_CMTO
@& Config CMT1 Data handling setting

& Config_CMT2
Transmit data handling Data handled in interrupt service routine ~

Interrupt setting
THIT priority Level 15 (highest) ~

TEI7 pricrity (Group ALD) Level 15 (highest) ~

Callback function setting
[ Transmission end

Figure 4-38 Config_SCI7 setting
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4.5.7 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK+. The conversion start trigger will be via the pin connected to SW3. Click

the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘Single Scan Mode S12AD’ as shown in Figure 4-39 then click ‘Next'.

Mew Component

Software Component Selection

Select component from those available in list

Type I Drivers VI
Function | All ~
Fitter | |
Components Type Version =
8 Real Time Clock Code Generator 150
8 5CI/SCIF Asynchronous Mode Code Generator 1.8.0
8 SCI/SCIF Clock Synchronous M. Code Generator 1.8.0
# Single Scan Mode 512AD Code Generator 2.0.0 I
8 Smart Card Interface Mode Code Generator 180
2 SPI Clock Synchronous Mode Code Generator 180
8 5Pl Operation Mode Code Generator 170
E\u‘oltage Detection Circuit Code Generator 1.8.0
## Watchdog Timer Code Generator 180 v
< >
Show only latest version
Description
This software component provides single scan mode configurations for 12-Bit A/D
Converter which the analog inputs arbitrarily selected are converted for only once in
ascending channel order.

Download more software components

Configure general settings...

@ < Back I MNext = I | Einish | Cancel

Figure 4-39 Select Single Scan Mode S12AD

Ensure that the 'Configuration name' is'Config_S12AD0' as shown in Figure 4-40 below then click ‘Finish’.

New Component

Add new configuration for selected component |

Single Scan Mode $12AD
Configuration name: Config_512AD0 |

Resource: 512AD0 ~

@ < Back Next > Tond

Figure 4-40 Ensure Configuration name - S12AD0
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Configure S12AD0 as shown in Figure 4-41 and Figure 4-42. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings

remain at their defaults.

Components =] -
.
type filter text

v [= Startup ~
~ [= Generic
f- r_bsp
W = Drivers
v [= Interrupt
& Config_ICU
v [= A/D Converter
& Config_S124D0
v [= I/O Ports
& Config_PORT
v [= Communications
& Config_SCI7
& Config SCIS
~ = Timers
& Config_CMTO
& Config_CMT1
& Config CMT2

Configure

 Basic setting

Note

When using the 12-bit A/D converter unit 0, do not use the PAD to P47, P03, P03, and P07 pins as output pins.
We also recommend not using the POD to P02, P90 to P93, PDO te PDV, and PED to PE7 pins as cutput pins.

Analog input mode setting
[[] Double trigger mode

Analog input channel setting

Eanooo ] ANODT ] ANDO2 ] ANDD3
] ANODS ] ANDDG ] ANOOT

Conversion start trigger setting

Start trigger source IND conversion start trigger pin I

Interrupt setting

Enable AD conversion end interrupt (S12AD0) Priority Level 15 (highest)
+ Advance setting
Add/Average AD value setting
[ Anooo ANODT ANOD2 AMNODD3 AMNDD4
ANOD5 ANODE ANOOT
Self diagnosis setting
Mode Unused ~
ov
Disconnection detection assist setting
Charge setting Unused ~
2ADCLE
Dedicated sample hold circuit channel setting
[ Anooo ANDDT ANOD2
Data registers setting
Data placement Right-alignment ~
Automatic clearing Disable automatic clearing ~
Conversion resolution 12-bit accuracy ~
Addition/Average mode select Addition mode ~
Addition count 1-time ~
Window function setting
(®) Disable () Enable

Window A/B operation setting

[JEnable comparison window &

Window A comparisan condition matched OR window B comparison condition matched

[JEnable comparison window B

[ ANCO4

Figure 4-41

Config_S12AD0 setting (1)
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A/D comparison A setting

Reference data Ofor camparison

Reference data 1 for comparison
Use comparator for ANODO
Use comparator for ANDD1
Use comparator for ANDD2
Use comparator for ANDD3
Use comparator for ANDD4
Use comparator for ANDDS

Use comparator for ANDDG

Use comparator for ANODT

A/D comparison B setting

0

0

Reference data 0 > A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value
Reference data 0 » A/D-converted value

Reference data 0 > A/D-converted value

Reference data 0 for comparisan 0
Reference data 1 for comparisan 0
Comparison B channel Unused

Reference data 0 » A/D-converted value

Input sampling time setting

Dedicated sample and hold circuit 0.4 (ps)  (Actual walue: 0400
AMNOOD/Self-diagnosis 0.183 | (us)  (Actual value 0.183)
AND0T 0.183 (ps)  (Actual walue: 0183)
AND02 0.183 (ps)  (Actual walue: 0183)
AND03 0.183 (ps)  (Actual walue: 0183)
AMNO0 0.183 {ps) {Actual value: 0183)
AMO0S 0.183 {ps) {Actual value: 0183)
AMO06 0.183 {ps) {Actual value: 0183)
AMOOF 0.183 {ps) {Actual value: 0183)

(Total conversion time: 0.567us)

Interrupt setting
Enable AD conversion compare interrupt A (S12CMPAI) Enable AD conversion compare interrupt B (S12CMPEBI)

Group BL1T priority Level 15 (highest)

Figure 4-42 Config_S12AD0 setting (2)
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4.6 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed at Pins page.

{"—:‘.‘3’ *8C_Tutorial.scfg 22

Pin configuration

Hardware Resource = laz 6%
Type filter text
2 A A

#F Clock generator
'17?,_ Clock frequency accuracy measurement

¢ Operating mode control
‘3; System control

#F Interrupt controller unit
w :17?, Multi-function timer pulse unit 3
MTUD
MTU1
MTU2
MTU3
MTU4
MTU3
MTUG
MTU7
MTU3
&% Port output enable 2 v
€ >

Pin Function Pin Number

Overview | Board | Clocks | Components Interrupts

Figure 4-43 The ‘Pins’ tabbed page

4.6.1 Change pin assignment of a software component

I

To change the pin assignment of a software component in Pin Function list. Click
by Software Components.

to change view to show

LJ"-“,} *SC_Tutorial.scfg &2
Pin configuration

Hardware Resource =] laz

Type filter text

Figure 4-44 Change view to show by Software Components
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Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQ12 to P44, IRQ13 to P45. Ensure the ‘Enable’ tick box of IRQ12 and IRQ13 are checked, as
shown in Figure 4-45.

Software Components B |3, |  PinFunction ~h | | =] | By e
Type filter text type filter text (* = any string, ¥ = any character) All ~
e ‘.i._ _bsp Enabled  Function Assignment Pin Mumber Direction Remarks

W' r_bsp .
- & &
o ‘,i‘ Compare Match Timer O IROO # Not assigned L Nntassfgned None
'. Confia CMTO [l IRQ1 # Not assigned # Not assigned  None
W C f'g_CMT1 O IRO2 # Not assigned # MNot assigned  Mone
onfi
. Conﬁg_CMTE [l IRO3 # Not assigned # Not assigned  None
9- O IRQ4 # Mot assigned # Mot assigned  Mone
v & Interrupt Controller .
= Config ICU [l IRQ3 # Not assigned # Not assigned  None
= #-‘P:Dr‘ts =< [l IRQE # Not assigned # Not assigned  None
= > Config PORT O IRQ7 # Not assigned # Not assigned  None
onfi
.i.* ) g- O IRQS # Not assigned # Not assigned  MNone
w2 SCI/SCIF Asynchronous Mode .
> Config SCIO [l IRQS # Mot assigned # Mot assigned  Mone
onfi
- bt 9- [l IRQ10 # Not assigned # Not assigned  None
w0 5Pl Clock Synchronous Mode .
> Config SCIT O IRQ11 # Mot assigned # Mot assigned  Mone
%‘S'_ e Mode S124D IRQ12 7 P4 R0 12/ AN ] s ca [
v ingle 5can Mode
= HQCDHH $12800 IRQ13 [Z_Pa5/RO13/AN005 ] # D1 |
® 9- O IRQ14 # Mot assigned # Not assigned  None
O IRQ15 # Not assigned # Not assigned  MNone
[l MNMI # Mot assigned # Mot assigned  Mone
< >
Pin Function Pin Number
Overview |Board | Clocks | Components | Pins | Interrupts

Figure 4-45 Configure pin assignment - Config_ICU

Select the Config_SCI9 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD9 and TXD9 are checked and Assignment column of RXD9 is PL1 and TXD9 is PL2
as shown in Figure 4-46.

Software Components = laz 6% Pin Function =l | | _§ﬂ| PR

Type filter text type filter text (* = any string, ¥ = any character) All w

v i#'- r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks

CTS0#
RTS9#

Wl or_bsp

-

Mot assigned # Mot assigned  Mone
Mot assigned # Mot assigned MNone
RXDS .| # 110 |
SCK9 Mot assigned ¥ Mot assigned MNone
THDS L#_PL2/GTETRGC/SMOSIS/SSDAG/TXDG/MISOC/ETD ...| # P12 0

v -4‘-'_ Compare Match Timer
w' Config_ CMTO
w! Config_CMT1
w' Config_ CMT2
v -#-. IrLterruptControIIer
@ Config_ICU
v -,i‘. Psr‘ts
W Config_PORT
~ . SCI/SCIF Asynchronous Mode
W Config_5CI9
w -#-_ 5PI Cleck Synchronous Mode
& Config 5CI7
v % Single Scan Mode 512D
& Config 512400

-

rd

HOEOO

Pin Function Pin Number

Overview | Board | Clocks  Components | Pins | Interrupts

Figure 4-46 Configure pin assignment - Config_SCI9
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Select the Config_SCI7 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK7 and SMOSI7 are checked and Assignment column of SCK7 is PHO, SMOSI7 is PH2
as shown in Figure 4-47.

Software Components = laz 6% Pin Function ~) | | _§ﬂ| Dy e

Type filter text type filter text (* = any string, = any character) All ~

v ‘-4‘: r_bsp
i r_bsp

v ﬁ; Compare Match Timer
' Config_CMTD
' Config CMT1
w' Config CMT2

v ‘,!‘: Interrupt Controller
& Config_ICU

v ‘3: Ports
@& Config_PORT

w ‘-4‘; SCI/SCIF Asynchronous Mode
& Config SCI8

v T SP| Clock Synchronous Mode
& Config SCI7

v ﬁ; Single Scan Mode 512AD

& Config 512400

Enabled  Function Assignment Pin Number Direction Remarks
SCK7 LZ_PHO/TICO/GTETRGA/SCK7/RSPCKA | 10

SMISOT7 # Mot assigned ¥ Mot assigned  MNone

SMasI7 L#_PH2/GTETRGC/SMOSIT/SSDAT/ TXDT/MISOA |7 )6 10

557# # Mot assigned # Mot assigned  Mone

OEOE

Pin Function Pin Number

Overview |Board | Clocks | Components | Pins | Interrupts

Figure 4-47 Configure pin assignment - Config_SCI7

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO#, AN00OO, AVCCO0, AVSS0, VREFHO and VREFLO are checked and Assignment
column of ANOOO is P40, ADTRGO0# is PO7 as shown in Figure 4-48.

Software Components = |3, &  PinFunction ~h | ‘ =] | By e
Type filter text type filter text (* = any string, ¥ = any character) All w
h ‘g’: r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks

N b
% o r-osp Motch T ADTRGOZ [7_PO7/IROT5/ADTRGE |7 Es5 I
v
e ANO0D [eza/Roz/AND0 ] # D4 |
onfi
. Cnnfig_CMﬂ O AN # Not assigned # Not assigned  MNone
W C f'g_CMTZ (] ANOD2 # Mot assigned # Mot assigned  Mone
ontia- O ANOD3 # Not assigned # Not assigned  MNone
~ . Interrupt Controller . .
L Config ICU O AN # Not assigned # Not assigned  MNone
" : " 9- [ ANDDS # Mot assigned # Mot assigned  Mone
v
b ECS fiq PORT O ANDDE # Not assigned # Not assigned  None
onfi
- & ) 9- [ ANOOT # Not assigned # Not assigned  Mone
w o SCISCIF Asynchronous Mode AVCCD TRCCD 7 B2 |
»' Config_5CI9 : )
vt ;JI Cloorlllcgs_ynchronous Mode AVSSD S Bt !
- VREFHD # VREFHO L |
W Config_5CI7
= VREFLO # VREFLO 4 A3 |
~ ™. Single Scan Mode 512AD
& Config_5124D0
£ >
Pin Function Pin Number
Owerview |Board | Clocks | Components | Pins | Interrupts

Figure 4-48 Configure pin assignment - Config_S12AD0

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘%l Generate Code’ at location of Figure 4-49.

{8 SC Tutorialscfg 31 = (=

Pin configuration

Figure 4-49 Generate Code Button
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If the Section Setting Dialog is displayed as shown in the Figure 4-50, Please check the box and click “Yes”.

The Console pane should report ‘Code generation is successful’, as shown Figure 4-51 below.

Section Setting

.

f ‘-I Current section setting of project may not be compatible with Smart Configurator

&Y' Do you want to change section setting?

Current section setting:

B_1,R_1,8_2,R_2,B,R B_8,R_8,5U,5//4, PResetPRG/FFCO0000,C_1,C_2,C,C_8, CSDSEC,CSBS
EC, CSINIT,CSVTBL,CSVECT,D_1,0_2,D,D_8,P,PIntPRG,W_1,W_2,W,L/FFC00100, EXCEPT
VECT/FFFFFF80,RESETVECT/FFFFFFFC

New section setting:

SU,51,B_1,R_1,B_2,R_2,B,R B_8,R_8/0xD00D0004,C_1,C_2,C,C_8,C5* D* W= L, P*/0xFFCO00
00,EXCEPTVECT/OxFFFFFF80, RESETVECT/OxFFFFFFFC

['Yes] to change section setting
[Mo] to keep current section setting
[Cancel] to cancel code generation

Dn not show again;

Yes Mo Cancel

Figure 4-50 Section Setting Dialog

After execution, close Smart Configurator and return to CS +.

& Console i
Smart Configurator Output

Ma4a00001 :
Ma4200001:
Ma4200001:
Ma4200001:
Ma4206001:
Ma4200001:
Ma4200001:
Ma4200001:
Me4aeee0l:
Ma4aaeasl :
Maseeealz :
Maseeaal2:
Maceeana?:
Maceeeee2:
MBseeeee2:
MBReeeee2:
Mazeeeeed:

File
File
File
File
File
File
File
File
File
File
File
File
File
File
File
Code
File

Eﬂ'|-=l

I

generated:srchsmc gen\general\r cg userdefine.h
generated:srchsmc gen\generallr smc entry.h
generated:srchsmc gen\generallr cg hardware setup.c
generated:srchsmc genl\generallr cg cmt.h
generated:srchsmc gen‘\generallr cg cmiw.h
generated:srchsmc gen\generall\r cg icu.h
generated:srchsmc gen\general\r cg port.h
generated:srchsmc gen'\generallr cg sl2ad.h
generated:srchsmc gen'\generallr cg sci.h
generated:srchsmc gen‘\generallr eg rspi.h
generated:srchsmc gen’\r pincfg\Pin.h
generated:srchsmc gen\r pincfg\Pin.c
generated:srchsmc gen\general\r smc interrupt.c
generated:srchsmc gen\generallr smc interrupt.h
generated:srchsmc gen\r confighr bsp interrupt config.h
generation is successful

modified:srchsmc_gen\r config\r bsp config.h

Figure 4-51 Smart Configurator console

When code generation is executed, the startup files generated at the time of CS+ project creation are
replaced with those generated by Smart Configurator. Figure 4-52 the project tree after code generation. In
the next chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file

to the project.

Project Tree L

5 © 3@

B i{5C Tutorial (Project)’|
.3 RSF572NNDxBD (Microcontroller)

% Smart Configurator (Design Tool)
LAy CC-RX (Build Tool)
.5 RX Simulator (Debug Tool)
i Program Analyzer (Analyze Tool)
-3 File
‘£]) Build tool generated files
& sC_Tutorial.c
11! Smart Configurator
[ Config_CMTD
[ Config_CMT1
[ Config_cMT2
[ Config_ICU
[ Config_PORT
[ 1 Config_5124D0
[ 1 Config_sCI7
[ 1 Config_sCI2
[ 1 general
[ r_bsp
[ r_config
[ r_pincfg

Figure 4-52 Smart Configurator folder structure
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5. Completing the Tutorial Project

5.1 Project Settings

In the ‘Project Tree’ pane, select
‘CC-RX (Build Tool). The build
properties will appear in the main
window.

Project Tree

: 0 2/E

EL.% 5C Tutorial (Project)”

CC-RX (Build Tool)

=3 File

i&, R3F5T2ZMNMNDxBD (Microcontroller)
Smart Configurator (Design Tool)

. R Simulater (Debug Tool)
! ::' Program Analyzer (Analyze Tool)

CS+ creates a single build
configuration called ‘Default Build’ for
the project. This has standard code
optimisation turned on by default.

“\ CC-RX Property

~ Build Mode
Build mode
Change property value for all build modes at once

~ CPU
Instruction set architecture
UUses single-precision floating-point operation instructions
Uses double-precision floating-point operation instructions
Endizan type for data
Rounding methed for floating-point constant cperations
Handling of denarmalized numbers in floating-point constants
Precision of the double type and long double type
Replaces the int type with the short type
Sign of the char type
Sign of the bit-field type
Selects the enumeration type size automatically
Order of bit-field members

Build mode
Selects the build mode name to be used during build.

Dief autt Build
No

Ri¥v3 architecture(4sa=nv3)

Yes(fpu)

Yes(-dpfpu)

Little-endian data(-endian=little)

round to nearest(-round=nearest)
Handles as zeros(-denomalize =off)
Handles in single precision(-dbl_size=4)
No

Handles as unsigned char(-unsigned_char}
Handles as unsigned({-unsigned_bitfield)
No

Allocates from right{bit_order=right)

', Common Options /4, CompileOptions (  AssembleOptions [ Link Options 4 Hex Output Options Library Generate
e Select the ‘Compile Options’ tab at ‘sg-ﬁx"meﬂv
the bottom of the properties window | | perreamrs S
Language of the C++ source file C++Hang=cpp}

pane. Under ‘Language of the C
source file’ select ‘C99(-lang=c99)’
as shown opposite.

Additional include paths

System include paths

Include files &t the head of compiling units

Macro definition

Invalidates the predefined macro

Enables information-level meszzage output
Suppresses the number of information-level messages
Undisplayed messages

Additional include paths[17]

System include paths[0]

Include files at the head of compiling unitz[0]
Macra definition [0]

No[-nomessage)

Changes the warning-level messages to information-level messages No
Changes the information-level messages to warning-level messages No
Language of the C source file

Selects language of the C source file.
This corresponds to the -lang option of the compiler.

' Common Options _}ICompileOptionslﬂ AssembleOptions ,( Link Options ,( Hex Qutput Options ,( Library Generate {

~ Section
Section start address
The specified section that outputs externally defined symbols to the file
Section alignment

e Select the ‘Link Options’ tab at the
bottom of the properties window

SUSLB_1.R_1.B 2R 2B.RB 8.R 8/4.C 1C 2CC 8C$ . D"W",
The specified section that outputs extemally defined symbols to the fie[]
Section alignment[0]

pane. Under ‘Section -> ROM to e ot te R mepped sctont] =
RAM mapped section’, add the three O _
ROM to RAM mapped section

Specifies ROM to RAM mapped section in the format of "<ROM section name>=<RAM section name>". ane per line.
This correspends te the -rom cption of the linker

mappings as shown opposite.

' Common Options / CompileOptions 4 AssembleOptions )| Link Options |{ Hex Output Options Library Generate Options
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« These settings are easily added by

clicking the button ‘...” and pasting I
the following text into the dialog:

uucc
'y D
e i s o u]
ol

D=R
D_1=R_1
D_2=R 2
D_8=R 8

e This ensures that the linker assigns Cancel ey
RAM rather than ROM addresses to
C variables. Click ‘OK’

e From the ‘Build’ menu, select ‘Build Tutorial - S+ for CC - [Project Tree]
Mode Settings...”. Click ‘Duplicate’
and in the resulting ‘Character String
Input’ dialog, enter ‘Debug’ for the
name of the duplicate Build Mode.

File Edit View Project |Build | Debug Tocl Window Help

@, start | [F [ Gl @&d| Build Project 7

Rebuild Project Shift+F7

Clean Project

Rapid Build

¢ 8 &

=-|_f% SC Tutorial (Proje
.38 RSFSTZNNDxB| ] Build SC_Tutorial

= . T_I
2 smart Configy £ g g ¢ Tutorial
R}

=% Update Dependencies

gl R Simulator [ Clean SC_Tutorial

T) Program Anak 35’ Update Dependencies of SC_Tutorial

Bj!' File . i# | Set Link Order of SC_Tuterial...
ﬂ Build tool
£] SC_Tutoria #1 Open the Optimization Performance Comparison Tool for SC_Tutorial...
&L smart Cont | s:0p Buila Cirl+F7
|_-|]| Config

[] config) Tt Build Mode Settings...
&Ll Config| )| Batch Build...

-]l Config
[] Config

=

Build Option List

Build Mode Settings

Selected build mode

Build mode list:

DefaultBuid

Character String Input

String
Debug
Hep Corcel |t
. 5 . . ¥ al [2] [=
e The new ‘Debug’ Build Mode will be | |% cofxfeey
~ Buil
added to the Build Mode list. Click N Ocfaut Buid v
‘ , . . Change property value for all build modes at once Default Build
Close’. Now, in the main CC-RX | |+ cru
. Instruction set architecture TAVS dICTIECTONET- T
Property WI nd OWy u nder the Uses single-precision floating-point operation instructions Yes({pu)
‘ H ’ H Uses double-precision floating-point operation instructions Yes(-dpfpu)
Com mon Optlons tab’ CIICk on the Endian type for data Little-endian data(-endian=little)
i ini ¢ H ’ H Rounding methed for floating-peint constant operations round to nearest(tound=nearest)
line contalnlng Build Mode ’ click the Handling of denormalized numbers in floating-point constants Handles as zeros(denomalize=off)
pU”-dOWﬂ arrow and select ‘Debug’ Precision of the double type and long double type Handles in single precision(dbl_size=4)
, Replaces the int type with the short type No
from the pu||-d0wn . Sign of the char type Handles as unsigned char(unsigned _char}
Sign of the bit-field type Handles as unsigned {unsigned_bitfield)
Selects the enumeration type size automatically No
Order of bit-field members Allocates from right (bit_order=right)
Assumes the boundary alignment value for structure members is 1 Nof-unpack)
Build mode

Selects the build mode name to be used during build.

‘ICommon Optionsl Compile Options AssembleOptions Link Options Hex Output Options Library Generate Options
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e In the ‘Frequently Used Options (for | “ cixrerey al 18l 1=
Compile)’”  group, select  the Build mode Debug
. L. . , . Change property value for all build modes at once No
Optimization Level’ option and select cPu
‘0’ from the pull-down. We have NOW | | GumatFiteType mdPah
created a ‘Debug’ Build Mode with e Basoktet
imi 1 1 v Frequently Used Opiions(for Compile)
no COde Optlmlsatlon and WI” be ﬁ-.d:!tlmnallmycludepalhs Additional include paths[17]
using the Build Mode to create and System include paths System include paths[l]
. Macro definition Macro defintion[0]
debug the prOJeCt Outputs debugging information Yes(-debug)
Optimization level 2(-optimize=2)
Dtputs additional information for inter-module optimization -om|ze=ﬂ:i
Optimization 1(-optimize=1
Dmputs ; seub r{::hsl file 2:fo§|muze=2§
w Frequently Used Options(for Assemble) Max(-optimize=max)
e Al of the sample code projects | “ fxreeey al 12 =
contained in this RSK+ are Build mode Release
" . . Change property value for all build modes at once No
configured with three Build Modes; oo
‘DefaultBuild’, ‘Debug’ and ‘Release’. | |- oummrieTypemiras
‘Release’ is created in the same way e e gt older bkt
as above; by duplicating ‘Default | | FeawentytecomostixConsle Addtionsl include pathsf17]
Build’. ‘Release’ Build Mode leaves Syseminclde pahs Syten nce ol
code optimisation turned on and Outpuis debugging informaion Yes(debug)
. . Optimization level 2(-optimize=2|
removes debug information from the iy —————————— o
. Optimization Optimizes with emphasis on code sizelsize)
OUtpUt flle' Dﬁputs atso;;r:hslﬁ\e N:'—nohsﬂile’; i I
. . Frequently Used Oplons(for Assemble)
e To remove debug information from | |+~ il S
the ‘Release’ Build Mode, in the ‘CC- Yes?Oulpulslmheumpulhle)[—DEEug)
RX Property’ window, select the ;ﬂﬂ:?ﬂ:ﬁm ::: :33i‘:iiﬂhfm”ffﬁf!mfii)ME (-5 Debug
‘Common Options’ tab at the bottom | | Freauenty tised Opfoms(iox Hox i) fetupe
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).
e Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.
e From the menus, select ‘File -> Save

All' to save all project settings.

5.2

Additional Folders

e Before new source files are added to - i
the project, we will create two : 03 _—
additional folders in the CS+ Project N U e e ]
Tree. Smart Config| 1] Rebuild SC_Tutorial
4, CC-RX (Build & Clean SC_Tutorial
e In the Project Tree pane, right-click fgﬁi‘o;i:r”ﬂ'j:gg S T —
the SC_Tutorial project and select 3 Fite Bl Windows Explorer Menu
‘Add -> Add NeW Category’ tJISEiI_‘:::;r: Add 3 +ﬂ Add Subproject...
-1} Smart Co fia SetSC_Tutorial as Active Project ,,ﬂ Add New Subproject...
Save Project and Development Tools as Package... ) AddFile...
i paste ctiey | ] Add Mew File..
i Rename F2 |1 Add New Category
Property
e Rename the newly-created ‘New SO g

Category’ folder to ‘C Source Files’.
Repeat these steps to create a new
category folder for ‘Dependencies’.

202

=

=]

C Tutorial (Project)”

4, CC-RX (Build Tool)

5[ File

R3F372MNDxBD (Microcontroller)
mart Configurator (Design Tool)

= RX Simulater (Debug Teol)
:5 Program Analyzer (Analyze Tool)

'[EB Build tocl generated files
5| SC_Tutorial.c
_l Smart Configurator

L e
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+.
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:

-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h

Copy these files in to the src folder below the workspace and then follow the steps below.

Refer to the Tutorial project folder

« Move the ‘SC_Tutorial.c’ file from

B B - | sCTutorial

click and select 'Remove from Project' to
exclude it from the project.

‘C:\Workspace\SC_Tutorial’ to L Home | Share  View
‘C:\WOI’kSpace\SC Tutorial\srcl. &« v P » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial
Mame ) - Date n
7 Quick access e
Debug
[ This PC DefaultBuild
[ Desktop Release J
== Documents ZUE
i Downloads j dbsct.c
J’ Music g hwsetup.c
o _|intprg.c
&=/ Pictures j iodefine.h
B videos \_'| lowlvl.src
%5 Local Disk (C:) “Nowsre.c
=¥ Network j lowsrc.h
j resetprg.c
j shrk.c
1 shrk.h
[ SC_Tutorial #5032, mtud
&) sC_Tutorial.mtpj
« Select SC_Tutorial.c on the project tree, Right- P"’“r = e
) =1

B_ﬁ SC Tutorial (Project)*
R3F372MMD=BD (Microcontroller)

Smart Configurator (Design Tool)

A, CC-RX (Build Tool)

e R Simulator (Debug Tool)

T) Program Analyzer (Analyze Tool)

&[0 File

ﬂ Build tool generated files
]

I_E Smart C @ Compile

I_E C Sourc _1-\ Open

...... [ ] Depend
_'-:f, Open with Internal Editor...
& Open with Selected Application...
g_.k Open Folder with Explorer
El Windows Explorer Menu
Add 2
FE_‘ Remove from Project Shift+Del
. . ¢ S - File
« Right-click on the ‘C Source Files’ folder and -] Build tool generated files
select ‘Add’ -> ‘Add File...". LB Smrt Configurator
[ Dependenci] _ Add vl 1 AddFile..

Bl| Open Folder with Explorer 9| Add MNew File...

=l Windows Explorer Menu . \:l, Add New Category
2l Remove from Project Shift+Del

3| Copy Ctrl+C

i5| Paste Cirl+V

d@ Rename F2

Property
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« Select the files to be added (ascii.c, e
r_Okaya_|Cd.C, SC_TUtOI'Ia|) from C. « v 4 <« Workspace » SC_Tutorial » src » v Search src pel
\Workspace\SC_Tutorial\src. Organize = Newfolder E- o @
7 Quick access e
smc_gen
B This PC 7 ascii.c
[ Desktop j r_okaya_lcd.c
[£ Documents | sC_Tutorial.c
¥ Downloads
D Music
&= Pictures
8 Videos
‘i Local Disk (C:)
=¥ Network
< >
File name: | "SC_Tutorial.c” "ascii.c" "r_okaya_lcd.c" v| C source file (*.c) ~
« Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the |JSEEESEES
'Dependencies' folder « v 4 <« Workspace » SC_Tutorial » src » v Search src pel
Organize = Mewfolder - @ @
Name -
Note: Select the Header file (* .h; * hpp; * .inc). # Quick access amegen
B This PC " asciih
[ Desktop j r_okaya_lcd.h
[£ Documents
¥ Downloads
D Music
&= Pictures
8 Videos
‘i Local Disk (C:)
=¥ Network
< >
File name: ‘"r_nkaya_\(d.h" "asciih" v| IHeaderfi\e (*.h; *.hpp; *.inc) VI
« Make sure the project tree is the same as the Project Tree 7 X
screen shot. 8 @ 8 @
BN | 5C Tutorial (Project)
: R5F372MMDxBD (Microcontroller)
D:,_j Srnart Configurator (Design Tool)
LAy, CC-RX (Build Tool)
=, RX Simulator (Debug Tool)
; {p Program Analyzer (Analyze Tool)
=-[J File
-EI!I Build tool generated files
|_—ﬂ| Smart Configurator
: ‘ﬂ SC_Tutorial.c
E[_E Dependencies
"J ascii.h
b r_ckaya_led b
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Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r smc_entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R LCD Display (0, (uint8 t *)" RSK+RX72N ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");
while (1U)

{

}

Indentation is lost when the code described in this manual is pasted into the CS+ source file. Also check that the
pasted code is correct.
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.5.6. In
the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI7’ and open the file ‘Config_SCI7.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI7 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the ‘Config_SCI7_user.c’ file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s sci7 txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI7:
static void r Config SCI7 callback transmitend(void)
{
/* Start user code for r Config SCI7 callback transmitend. Do not edit comment generated here */

s_sci7 txdone = TRUE;

/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

J Rk Kk ok kA KRR A A K KAk k ok h ok kKA XA E Kk khhh kA AAA KA KA KKk k ok k ok kA XA KKK K&k kK kkkokkx

* Function Name: R_SCI7_ SPIMasterTransmit

* Description : This function sends SPI7 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/

MD STATUS R _SCI7 SPIMasterTransmit (uint8 t * const tx buf,
const uintl6_t tx num)
{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s _sci7 txdone = FALSE;

/* Send the data using the API */
status = R _Config SCI7_ SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s sci7 txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI7 SPIMasterTransmit

KAk Ak Ak kA kA kA Ak A A Ak A A A A A A A A A A A A A A A A A A A A A A A KA KA A A A KA KA A A A KA KA KA A KA KA K I A KA KA KK A KK

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in §4.5.2. In the CS+ Project Tree,
expand the ‘Smart Configurator\Config_ CMTO0\Config_ CMTO0.h’ and insert the following code in the user area
for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t gs one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO cmiO_interrupt. Do not edit comment generated here */

gs_one ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

[ KKk k ok ok kKA A A A KKKk ko k k ok ok kKA A AR KA KKKk ok k k k ok ok kA AR A KA KKKk kK kkk ok kAR AR A KKKk Kk k ok ok ok ok ok

* Function Name: R_CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
‘k‘k‘k‘k*******‘k‘k‘k‘k‘k‘k‘k********‘k‘k‘k‘k‘k‘k********‘k‘k‘k‘k‘k‘k‘k********************************/
void R _CMT MsDelay (const uintlé t millisec)

{

uintlé t ms count = 0;

do

{
R Config CMTO_ Start();
while (FALSE == gs_one ms_delay complete)
{

/* Wait */

}
R Config CMTO Stop();
gs_one_ms_delay complete = FALSE;
ms_count++;

} while (ms_count < millisec);

}

KKK K K kK K K Kk K K K K K kK K K R K R R R kK R R R ok K R R R R K R R R kK R R R Rk R Rk Rk R Rk Rk ok

End of function R CMT MsDelay
*******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSK+RX72N
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSK+. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx72ndef.h
-r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

The switch code uses interrupt code in the files Config_ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config ICU.c, Config ICU_user.c, Config CMT1.h, Config_ CMT1.c, Config CMT1_user.c,
Config_ CMT2.h, Config_ CMT2.c, and Config CMT2_user.c, as described in §4.5.2 and §4.5.3. 1t is
necessary to provide additional user code in these files to implement the switch press/release detection and
de-bouncing required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);
void R _ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the ‘Config_ICU.c’ file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

VARREEEEEE LSRR EEE St EEEE Rt EEE Rt EE R E

* Function Name: R_ICU_ IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU IRQ is set to

* falling edge triggered, otherwise 0.

* Arguments : uint8 t irg no

* Return Value : 1 if falling edge triggered, 0 if not
*******************************************************************************/

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)
{
uint8_t falling edge trig = 0x0;
if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)

{
falling edge trig = 1;
}

return (falling edge trig);
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R_ICU_IRQIsFallingEdge

LR EEEEE RS AR EEEE LR AR R EEEE R EE Rt

VAREEEEEEE RS SRR R R LA EEE Rt EEE Rt EE Rt

* Function Name: R_ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k**********************~k~k~k~k~k~k~k~k~k~k***********************/

void R ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;
}

else

{
ICU.IRQCR[irg nol] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R ICU IRQSetFallingEdge

LR EEEE RS SRR EEE SR EEEE R EEEE R R Rt

VAREEEEEEE SRR EEE Rt EEE Rt EEEEE R R R Rt

* Function Name: R ICU IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/
void R ICU IRQSetRisingEdge (const uint8 t irq no, const uint8 t set r edge)
{
if (1 == set_r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;
}
else
{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;
}
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R _ICU_IRQSetRisingEdge

LR R EEE R RS EEEEE SRR EE AR EEE R R Rt

/* End user code. Do not edit comment generated here */
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Open the ‘Config_ICU _user.c’ file and insert the following code in the user code area for include near the top
of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg13_interrupt:

/* Start user code for r Config ICU irgl3 interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg12_interrupt:

/* Start user code for r Config ICU irgl2 interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.4.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_ CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_ CMT1_user.c’ file insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT2’ folder and open the ‘Config_ CMT2_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file and insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In §4.5.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include "r smc entry.h"
finclude "r okaya lcd.h
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Init();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX72N ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R_Config S12AD0_Get_ ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then add the definition for the switch call-back, get_adc and lcd_display_adc functions adding at the below of

the main function, as shown below:

KA KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A Ak Ak Ak Ak kK, Kk

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/

static void cb switch press (void)
{
/* Check if switch 1 or 2 was pressed */
if (g_switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))

{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}
}

/******************************************************************************
* End of function cb switch press

******************************************************************************/
/******************************************************************************

* Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintlé t adc value

******************************************************************************/
static uintl6_t get_adc (void)
{

/* A variable to retrieve the adc result */

uintlé t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R S12AD0 SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc_complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R _S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R _Config S12ADO_Start();

return (adc_result);

}

/******************************************************************************

* End of function get adc
******************************************************************************/
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintl6é_t adc_result)
{

/* Declare a temporary variable */
char t a;

/* Declare temporary character string */
char t lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (a < 0x0A) 2 (a + 0x30) : (a + 0x37);
a = (char_t) ((adc_result & 0xO00FO0) >> 4);

lcd buffer[7] = (a < 0xO0A) ? (a + 0x30) : (a + 0x37);
a = (char t) (adc_result & 0x000F);

lcd buffer[8] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);

/* Display the contents of the local string lcd buffer */
R _LCD Display(3, (uint8 t *)lcd buffer);

}

/******************************************************************************

* End of function lcd display adc

******************************************************************************/

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following type define in between the user code delimiter comments as
shown below.

/* Start user code for type define. Do not edit comment generated here */

typedef char char t;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config  S12AD0O’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R S12AD0 SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */
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Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStart (void)
{
IR (PERIB, INTB186) = 0U;
IEN (PERIB, INTB186) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0_ SWTriggerStart

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k**************************/

VAREEEEEE RS EREEEEEEE Rt R R R EE Rt EEEEE Rttt EEE Rt

* Function Name: R _S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R S12AD0_SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (PERIB, INTB186) = 0U;
IR(PERIB, INTB186) = 0U;

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0 SWTriggerStop

LR EE SRRt R R R R EE R R R R EE Rt EEEEE Rt EE Rt

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0_user.c’ and insert the following code in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r_ Config S12AD0_interrupt (void)
{
/* Start user code for r Config S12AD0_interrupt. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK+ serial port are provided with the RSK+. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

-r_rsk_debug.c

-r_rsk_debug.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R _SCI9 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config_ SCI9’ folder and open the file ‘Config_SCI9.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI9 AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI9 _user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s sci9 txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI9_callback_transmitend function:

static void r Config SCIS callback transmitend (void)
{
/* Start user code for r Config SCI9 callback transmitend. Do not edit comment generated here */

s_sci9 txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area
inside the r_Config_SCI9_callback_receiveend function:

static void r Config SCIS callback receiveend(void)

{

/* Start user code for r Config SCI9 callback receiveend. Do not edit comment generated here */

/* Check the contents of g rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI9 receive buffer and callback function again */
R Config SCI9 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/*******************************************************************************

* Function Name: R SCI9 AsyncTransmit

* Description : This function sends SCI9 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx_num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

‘k******‘k***************:********:**********************************************/
MD_STATUS R_SCIS AsyncTransmit (uint8 t * const tx _buf, const uintl6_t tx_ num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s _sci9 txdone = FALSE;

/* Send the data using the API */
status = R Config SCI9 Serial Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s_sci9 txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI9 AsyncTransmit

R e 3

5.6.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’.

declaration to above the ‘main’ function:

#include "r smc _entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI9.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 _t get adc(void);

Add the following
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/* Prototype declaration for lcd display adc */

static void lcd display adc (const uintlé_t adc_result);

/* Prototype declaration for uart display adc */

static void uart display adc(const uint8 t adc count,

/* Variable to store the A/D conversion count for user display */
static uint8 t s adc count = 0;

Add the following highlighted code to the main function:

void main (void)

{

/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SWl or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */

R _LCD Display (0, (uint8 t *)" RSK+RX72N ");
R _LCD Display(l, (uint8 t *)" Tutorial ");
R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

/* Set up SCI9 receive buffer and callback function */
R Config SCI9 Serial Receive((uint8 t *)&g rx char,

/* Enable SCI9 operations */
R Config SCI9 Start():;

while

{

(10)

uintlé t adc result;

1);

/* Wait for user requested A/D conversion flag to be set (SWl or SW2)

if

{

}

(TRUE == g_adc_trigger)

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s _adc_count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}
/* Send the result to the UART */
uart display adc(s_adc count, adc result);

/* Reset the flag */
g _adc_trigger = FALSE;

/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */

else if (TRUE == g adc complete)

{

/* Get the result of the A/D conversion */
R Config S12AD0 Get ValueResult (ADCHANNELO,

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

&adc_result);

const uintl6_t adc_result);

*/
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/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition in the end of the file:

VAR AR AEEEEEE RS iR R et E R

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8 t : adc_count

* uintlé t: adc result

* Return value : none

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k*******************************************/

static void uart display adc (const uint8 t adc_count, const uintlé t adc_result)

{

/* Declare a temporary variable */
char t a;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.

Casting to ensure use of correct data type. */

a = (char t) (adc_count & 0x000F);

uart buffer[4] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char_t) ((adc_result & 0x0F00) >> 8);

uart buffer[l4] = (a < 0xO0A) ? (a + 0x30) : (a + 0x37);
a = (char t) ((adc_result & 0xO00FO0) >> 4);

uart buffer[15] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char_t) (adc_result & 0xO000F);

uart buffer[1l6] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);

/* Send the string to the UART */
r debug print (uart buffer);

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

* End of function uart display adc

LR EEEE RS e EEEE AR R EEE RS R R

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. Connect the RSK+ G1CUSBO port to a
USB port on a PC. If this is the first time the RSK+ has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &

LPT)" as 'RSK+ USB Serial Port (COMx)", where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI9 (Baud Rate:

19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result

to the PC terminal program via the SCI9.
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5.7 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI9.h"
#include "rskrx72ndef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc_ result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1l or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R_LCD Tnit();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX72N ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI9 receive buffer and callback function */
R Config SCI9 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI9 operations */
R Config SCI9 Start();

while (10)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2) */
if (TRUE == g_adc trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

R20UT4439EG0100 Rev. 1.00 RRENESAS Page 60 of 67
Nov.29.19



Renesas Starter Kit+ for RX72N 5. Completing the Tutorial Project

/* Increment the s _adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */

uart display adc(s_adc_count, adc result);

/* Reset the flag */

g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc complete)
{

/* Get the result of the A/D conversion */

R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDS0-3
* Argument : uint8 t count

* Return value : none

******************************************************************************/
static void led display count (const uint8_t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);
LEDLl = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8 t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) ? LED ON : LED OFF);

}

/**************************************~k***************************************

* End of function led display count
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The code will perform the same but now

the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

6.

Debugging the Project

e In the ‘Project Tree’ pane, right-click the | JEEEEMIES 1 x
‘RX Simulator (Debug Tool).  Select 8 B 23
‘Using Debug Tool -> RX E2 Lite’. = F SC Tutorial (Project)”
#, R3F37T2ZMMND=ED (Microcontroller)
. :~I Smart Cenfigurator (Design Toel)
A, CC-RX (Build Tool)
R Simulator Dcbug Tacas]
o ¥ Program Analyzer (An Using Debug Tool  » | RXE2
e (3} File 3 Property RXE2 Lite
L] Build taol generatéurm ;
|_]_ Smart Configurator RX E1(Serial)
|_]_ C Source Files RX E1(JTAG)
|_l Dependencies R E20(Serial)
RX E20(JTAG)
RX Simulator
e Double-click ‘RX E2 Lite (Debug Tool)' to | |FF Property
display ‘ the ,debugger tool prppertles. S0 FX £2 Lto Property
Under ‘Clock’, change the main clock | | internal ROMRAM
frequency to 24MHz, Communications | Size ofinternal ROM[KBytes]  [ElEg
‘ ’ : Size of internal RAM[KEytes] 1024
method :JTAG and operating frequency to Size of DataFlah memory{KBytes] b
240MHz. v Clock
. . . Main clock source EXTAL
o All other settings can remain at their Main clock frequencylMHz] 24.0000
defaults. Operating frequency[MHz] 2400000
Allow changing of the clock source on writing internal flash memory No
~ Connection with Emulator
Emulater serial No.
~ Connection with Target Board
Fawer target from the emulator. (MAX 200m) Mo
Communications method JTAG
e Connect the E2 Lite to the PC and the
RSK+ E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.
e Connect the center positive +5V PSU to
the PWR connector on the RSK+ and
apply power.
e From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK+ device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support

For details on how to use CS+, refer to the help Window | Help|
file by opening CS+, then selecting Help > Help P |@ T
Contents from the menu bar. & L& e
i @+ Open Help for Main window F1
| How to Access Help [
qlq One Point Advice...
BB Tutorial

@] Browse Renesas Electronics Microcentrollers Web
5«}, Privacy Settings...

(i Detail Version Information..,

i_‘!,' Check for Updates...

Launch License Manager...

[EY About...

For information about the RX72N group microcontroller refer to ‘RX72N Group User’s Manual: Hardware’.
For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.
Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of

this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2019 Renesas Electronics Europe GmbH. All rights reserved.
© 2019 Renesas Electronics Corporation. All rights reserved.
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